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Blink | Arduino 1.8.5

Blink §
This example code is in the public domain.

hitp:/
.

// the setup function runs once when you press reset or power the board
void setup(Q {
// initialize digital pin LED_BUILTIN as an output.
pinMode(LED_BUILTIN, OUTPUT);
}

// the loop function runs over and over again forever

void loop() {$
digitalWrite(LED_BUILTIN, HIGH); // turn the LED on (HIGH is the voltage level)
delay(1000); // wait for a second
digitalWrite(LED_BUILTIN, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

}

32 Arduino/Genuino Uno on COM1
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®* Something you can touch and feel — the Hardware

® A program that allows us to

® write programs to control the Hardware

® copy those programs to the Hardware

Blink §
This example code is in the public domain.
ink
// the setup function runs once when you press reset or power the board
void setup() {

// initialize digital pin LED_BUILTIN as an output.
pinMode(LED_BUILTIN, OUTPUT);

// the loop function runs over and over again forever

void loop() {$
digitalWrite(LED_BUILTIN, HIGH); // turn the LED on (HIGH is the voltage level)
delay(1000); // wait for a second
digitalWrite(LED_BUILTIN, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

32 Arduino/Genuino Uno on COM1
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® A simple, customizable computer
®* Computers take in inputs, perform operations, and generate outputs based on
) how they're programmed
® Examples
® Inputs: pressing buttons, reading a sensor, code from a programmer
®* Operations: doing math, moving and keeping track of information

® Outputs: blinking light, sound, driving a motor
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®* Computers are

* Don't expect succe

l ® Ask for help
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FEW THINGS

* Get program
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* Get programs from SparkFun Inventor's Kit Examples Folder

\l 2024 Techcamp

. 2024 Tech Camp Presentation St. Ignatius

O . 2024 Tech Camp Presentation Ronan
. SparkFun Inventor's Kit Arduino Code V4.0

 SparkFun Inventor's Kit Arduino Code V4.1
» SparkFun Inventor's Kit Guide Book V4.1

Right click and save to Desktop
Go to Desktop - SparkFun Inventor's Kit L.CD Errata

Double click on File

2023 Spring Technology in the Classroom Showcase

. littleBits

- Raspberry Pi

Other Resources

SIK-Guide-Code- - Eagle Design Libraries
V40.zip
- ENGG Code
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Blink §
This example code is in the public domain.

hitp:/
.

// the setup function runs once when you press reset or power the board
void setup(Q {
// initialize digital pin LED_BUILTIN as an output.
pinMode(LED_BUILTIN, OUTPUT);
}

// the loop function runs over and over again forever

void loop() {$
digitalWrite(LED_BUILTIN, HIGH); // turn the LED on (HIGH is the voltage level)
delay(1000); // wait for a second
digitalWrite(LED_BUILTIN, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

}

32 Arduino/Genuino Uno on COM1
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® File -> Open
SIK-Guide-Code-V40
SIK_Circuit _1A-Blink

File Edit

sketch_mar18a | Arduino IDE 2.3.2
Sketch Tools Help

New Sketch Ctrl+N
New Cloud Sketch ~ Alt+Ctrl+N
Open... Ctrl+O
Sketchbook

Examples

Close
Save

Save As...

Preferences...

Ctrl+W
Ctrl+S
Ctrl+Shift+S

Ctrl+Comma

Advanced

Quit

Ctrl+Q

Installing Mouse@l1.0.1
Installed Mouse@1.0.1

tup code here,

to run once:

Ln 1, Col 1

X No board selected
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sketch_mar18a | Arduino IDE 2.3.2
File Edit Sketch Tools Help
Auto Format Ctrl+T
Archive Sketch
sketch_m Manage Libraries... Ctrl+Shift+|
Serial Monitor Ctrl+Shift+M
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Serial Plotter

Firmware Updater

Upload SSL Root Certificates

Board Boards Manager...  Ctrl+Shift+B L
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Port
Get Board Info
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Arduino Uno
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®

Burn Bootloader at: ht . {Tun.cc Arduino Uno Mini
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Arduino Duemilanove or Diecimila
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N

® . Arduino Nano
Tools -> Board -> Arduino AVR Boards SR
Arduino Mega ADK
pinMode(13, OUTPUT); ot pin 13 output Arduino Leonardo

Arduino Leonardo ETH
Arduino Micro
Arduino Esplora
Arduino Mini
Arduino Ethernet

void loop() {

digitalWrite(13, HIGH); // Turn he ) Arduino Fio
Arduino BT

delay(2000); S nas LilyPad Arduino USB
LilyPad Arduino

digi Wri : // Turn off the LED
AgAREiNERERCEY,  LOW) s BER - ' Arduino Pro or Pro Mini

delay(2000); // Wait for two s Ardamio NG sk clder
Arduino Robot Control
Arduino Robot Motor
Arduino Gemma

Adafruit Circuit Playground
Arduino Yan Mini

Arduino Industrial 101

Linino One

Ln 31 Arduino Uno WiFi



sketch_mar18a | Arduino IDE 2.3.2
File Edit Sketch Tools Help

sketch_mar18a.ino
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Fun In
rcuit 1A-

Turns an LED )in 13 on and off. Repeats fo

with 1 ( n the Arduino community.

W oo NOUVAE WN
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/tutorials/ kfun-invento

e o
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void setup() {

=
o n

pinMode(13, OUTPUT); // Set pin 13 to output

NN B
= ® W 0 N

void loop() {

NN
w N

digitalWrite(13, HIGH);

NN
v oA

delay(2000);

NN
N o

digitalWrite(13, LOW);

NN
O

delay(2000);

w w
= ®

is

Sketch uses 924 bytes (2%) of program storage space. Maximum 32256 bytes.

Global variables use 9 bytes (0%) of dynamic memory, leaving 2039 bytes for local variables. Maximum

Ln 31,Col 2 Arduino Uno [not connected] (31 B3
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RUN IT ON THE HARDWARE




sketch_mar18a | Arduino IDE 2.3.2
File Edit Sketch Tools Help

sketch_mar18a.ino
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with 1 ( n the Arduino community.
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void setup() {

=
o n

pinMode(13, OUTPUT); // Set pin 13 to output

NN B
= ® W 0 N

void loop() {

NN
w N

digitalWrite(13, HIGH);

NN
v oA

delay(2000);

NN
N o

digitalWrite(13, LOW);

NN
O

delay(2000);

w w
= ®

is

Sketch uses 924 bytes (2%) of program storage space. Maximum 32256 bytes.

Global variables use 9 bytes (0%) of dynamic memory, leaving 2039 bytes for local variables. Maximum

Ln 31,Col 2 Arduino Uno [not connected] (31 B3
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Circuit TA:
Blinking an LED

NEW COMPONENTS

LIGHT-EMITTING DIODES (LEDS)
are small lights made from a silicon diode.
They come in different colors, brightnesses
and sizes. LEDs (pronounced el-ee-dees)
have a positive (+) leg and a negative (-)
leg, and they will only let electricity flow
through them in one direction. LEDs can
also burn out if too much electricity flows
through them, so you should always use a
resistor to limit the current when you wire
an LED into a circuit.

RESISTORS resist the flow of electricity.
You can use them to protect sensitive
components like LEDs. The strength of a
resistor (measured in ohms) is marked on
the body of the resistor using small colored
bands. Each color stands for a number,

which you can look up using a resistor chart.
One can be found at the back of this book.

|
33004 RESISTOR 2 JUMPER WIRES

You can find LEDs in just about any source
of light, from the bulbs lighting your home
to the tiny status lights flashing on your
home electronics. Blinking an LED is the
classic starting point for learning how to
program embedded electronics. It'’s the
“Hello, World!” of microcontrollers. In this
circuit, you’ll write code that makes an LED
blink on and off.

'y YOU
NEED

NEW CONCEPTS

POLARITY: Many electronics
components have polarity,
meaning electricity can (and
should) flow through them in
only one direction. Polarized
components, like an LED, have a
positive and a negative leg and
only work when electricity flows
through them in one direction.
Some components, like resistors,
do not have polarity; electricity
can flow through them in either direction.

OHM’S LAW describes the relationship between
the three fundamental elements of electricity:
voltage, resistance and current. This
relationship can be represented by this equation:

V=I*R

V = Voltage in volts
1 = Current in amps
R = Resistance in ohms (£2)

This equation is used to calculate what resistor
values are suitable to sufficiently limit the current
flowing to the LED so that it does not get too hot
and burn out.

13 : CIRCUIT 1A




DIGITAL OUTPUT: When working with
microcontrollers such as the RedBoard, there

are a variety of pins to which you can connect
electronic components. Knowing which pins

perform which functions is important when

building your circuit. In this circuit, we will be

using what is known as a digital output. There

are 14 of these pins found on the RedBoard.

A digital output only has two states: ON or

OFF. These two states can also be thought of
as HIGH or LOW, TRUE or FALSE. When an LED is connected to one of these pins, the pin
can only perform two jobs: turning on the LED and turning off the LED. We’ll explore the
other pins and their functions in later circuits.

pm— T ey
NEW IDEAS

RESISTOR
LEADS
Components like resistors need to have
their legs bent into 90° angles in order to
correctly fit in the breadboard sockets.

FLAT EDGE

———— ] ———————————

SHORT LEG

POLARIZED
COMPONENTS

Pay close attention to the LED. The

negative side of the LED is the short leg,
marked with a flat edge.

14 : CIRCUIT 1A



DIGITAL OUTPUT: When working with
microcontrollers such as the RedBoard, there
are a variety of pins to which you can connect
electronic components. Knowing which pins
perform which functions is important when
building your circuit. In this circuit, we will be
using what is known as a digital output. There
are 14 of these pins found on the RedBoard.
A digital output only has two states: ON or
OFF. These two states can also be thought of
as HIGH or LOW, TRUE or FALSE. When an LED is connected to one of these pins, the pin
can only perform two jobs: turning on the LED and turning off the LED. We’ll explore the
other pins and their functions in later circuits.

ircuits while the board is connected to

a power source. The SparkFun RedBoard operates at 5 volts, which, while not enough to

injure you, is enough to damage the components in your circuit.

RESISTOR
LEADS

Components like resistors need to have
their legs bent into 90° angles in order to
correctly fit in the breadboard sockets.

FLAT EDGE

]| pr——

SHORT LEG
POLARIZED
COMPONENTS

Pay close attention to the LED. The
negative side of the LED is the short leg,
marked with a flat edge.
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DIGITAL OUTPUT: When working with
microcontrollers such as the RedBoard, there

are a variety of pins to which you can connect

electronic components. Knowing which pins

perform which functions is important when

building your circuit. In this circuit, we will be

using what is known as a digital output. There

are 14 of these pins found on the RedBoard.

A digital output only has two states: ON or

OFF. These two states can also be thought of
as HIGH or LOW, TRUE or FALSE. When an LED is connected to one of these pins, the pin
can only perform two jobs: turning on the LED and turning off the LED. We’ll explore the
other pins and their functions in later circuits.

- |

ELECTRICAL SAFETY: ircuits while the board is connected to
a power source. The SparkFun RedBoard operates at 5 volts, which, while not enough to
injure you, is enough to damage the components in your circuit.

* DISCONNECT USB Cable before wiring circuits

LEADS
Components like resistors need to have
their legs bent into 90° angles in order to
FLAT EDGE -
correctly fit in the breadboard sockets.
]| pr——

SHORT LEG

POLARIZED
COMPONENTS

Pay close attention to the LED. The
negative side of the LED is the short leg,
marked with a flat edge.

14 : CIRCUIT 1A
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DIGITAL OUTPUT: When working with
microcontrollers such as the RedBoard, there

are a variety of pins to which you can connect

electronic components. Knowing which pins
perform which functions is important when
building your circuit. In this circuit, we will be
using what is known as a digital output. There
are 14 of these pins found on the RedBoard.

A digital output only has two states: ON or
OFF. These two states can also be thought of

ins, the pin
FLAT EDG \

SHORT LEG

kplore the

POLARIZED
COMPONENTS

Pay close attention to the LED. The

negative side of the LED is the short leg,
marked with a flat edge.

: CIRCUIT 1A
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DIGITAL OUTPUT: When working with
microcontrollers such as the RedBoard, there
are a variety of pins to which you can connect
electronic components. Knowing which pins
perform which functions is important when
building your circuit. In this circuit, we will be
using what is known as a digital output. There
are 14 of these pins found on the RedBoard.

A digital output only has two states: ON or
OFF. These two states can also be thought of

RESISTOR
LEADS

Components like resistors need to have

their legs bent into 90° angles in order to

correctly fit in the breadboard sockets.




Open the Arduino IDE

Connect the RedBoard to a USB port on your computer.

Open the Sketch: File > Examples > SIK-Guide-Code-master > CIRCUIT_1A-BLINK

Select UPLOAD to program the sketch on the RedBoard.

o G Edit Sketch Tools Help

New

Open

Open Recent

Sketchbook

P 01.Basics

02.Digital
03.Analog
04.Communication
05.Control
06.Sensors
07.Display
08.Strings
09.USB
10.Starter Kit
ArduinolSP
SIK-Guide-Code-master

16 : CIRCUIT 1A
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WHAT YOU
SHOULD SEE

The LED will flash on for two seconds, then
off for two seconds. If it doesn’t, make sure
you have assembled the circuit correctly

and verified and uploaded the code to your
board. See the Troubleshooting section at the
end of this circuit if that doesn’t work. One
of the best ways to understand the code you
uploaded is to change something and see
how it affects the behavior of your circuit.
What happens when you change the number

in one or both of the [SENEI @1::[:)

lines of code (try 100 or 5000)?




FIRST CIRCUIT

WHAT YOU
SHOULD SEE

The LED will flash on for two seconds, then
off for two seconds. If it doesn’t, make sure
you have assembled the circuit correctly

and verified and uploaded the code to your
board. See the Troubleshooting section at the

end of this circuit if that doesn’t work. One
of the best ways to understand the code you
uploaded is to change something and see
how it affects the behavior of your circuit.
What happens when you change the number
in one or both of the (2000);
lines of code (try 100 or 5000)?




PROGRAM OVERVIEW

Turn the LED on by sending power (5V) to digital pin 13.

Wait 2 seconds (2000 milliseconds).
Turn the LED off by cutting power (0V) to digital pin 13,
Wait 2 seconds (2000 milliseconds).

Repeat.

NEW IDEAS

CODE TO NOTE: The sketches that accompany each circuit introduce new progr ing techniques and

concepts as you progress through the guide. The Code to Note section highlights specific lines of code from the
sketch and explains them in greater detail.

CODE TO NOTE

SETUP AND LOOP: Every Arduino program needs these two functions. Code that goes in

between the curly brackets {} of setup () runs once. The code in
void setup(){} & between the Loop () curly brackets {} runs over and over until the
void loop(){} RedBoard is reset or powered off.

Before you can use one of the digital pins, you need to tell the RedBoard
INPUT OR OUTPUT?: whether it isan INPUT or OUTPUT. We use a built-in “function” called

pinMode() tomake pin 13 a digital output. You'll learn more about

pinMode(13, OUTPUT);
digital inputs in Project 2.

17 : CIRCUIT 1A




CODE TO NOTE

DIGITAL OUTPUT: ‘When you're using a pin as an OUTPUT, you can command it to be

HIGH (output 5 volts) or LOW (output 0 volts).

digitalWrite(D13, HIGH);

Causes the program to wait on this line of code for the amount of
DELAY: time in between the brackets, represented in milliseconds (2000ms
delay(2000); = 2s). After the time has passed, the program will continue to the

next line of code.

COMMENTS: Comments are a great way to leave notes in your code explaining

//This is a comment why you wrote it the way you did. Single line comments use two

forward slashes / /, while multi-line comments start with a /* and
/* So is this */ end witha */.

NEW IDEAS

CODING CHALLENGES: The Coding Challenges section is where you will find suggestions for changes
to the circuit or code that will make the circuit more challenging. If you feel underwhelmed by the tasks in each
circuit, visit the Coding Challenges section to push yourself to the next level

CODING CHALLENGES

PERSISTENCE OF VISION: Computer screens, movies and the lights in your house all flicker so
quickly that they appear to be on all of the time but are actually blinking faster than the human eye can detect.
See how much you can decrease the delay time in your program before the light appears to be on all the time

but is still blinking.

MORSE CODE: Tryadding and changing the [SERENI§ ) values and adding more
ERESATINS RN § ) commands to make your program blink a message in Morse code.

TROUBLESHOOTING

I get an error when ‘The most likely cause is that you have the wrong board selected in the Arduino
uploading my code IDE. Make sure you have selected Tools > Board > Arduino/Genuino Uno.

18 : CIRCUIT 1A
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CODE TO NOTE

DIGITAL OUTPUT: ‘When you're using a pin as an OUTPUT, you can command it to be

= 7 v
(D13 HIGH (output 5 volts) or LOW (output 0 volts).

Causes the program to wait on this line of code for the amount of
time in between the brackets, represented in milliseconds (2000ms
= 2s). After the time has passed, the program will continue to the

next line of code.

COMMENTS: Comments are a great way to leave notes in your code explaining
== coamet why you wrote it the way you did. Single line comments use two
forward slashes / /, while multi-line comments start with a /* and

& So s this */ end witha */.

CODING CHALLENGES

PERSISTENCE OF VISION: Computer screens, movies and the lights in your house all flicker so
quickly that they appear to be on all of the time but are actually blinking faster than the human eye can detect.
See how much you can decrease the delay time in your program before the light appears to be on all the time

but is still blinking.

MORSE CODE: Tryadding and changing the PA® P values and adding more

m commands to make your program blink a message in Morse code.

1 get an error when The most likely cause is that you have the wrong board selected in the Arduino
uploading my code IDE. Make sure you have selected Tools > Board > Arduino/Genuino Uno.

18 : CIRCUIT 1A
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HOOKUP TABLES: Many electronics beginners find m
it helpful to have a coordinate system when building their
..means one end of a
circuits. For each circuit, you'll find a hookup table that component connects
lists the coordinates of each component or wire and where to digital pin 13 on
it connects to the RedBoard, the breadboard, or both. The your RedBoard and
breadboard has a letter/number coordinate system, just the other connects to
J2 on the breadboard

like the game Battleship.

(VTS CTR AN ¢ REDBOARD CONNECTION = BREADBOARD CONNECTION
sumper wires ( #D13wm J2 )( #GNDwm E1

" AL() o m A2(+) In this table, a yellow

highlight indicates that a

component has polarity
3300 RESISTOR and will only function if
(ORANGE, ‘:':;Ao.:f:i properly oriented.

15 : CIRCUIT
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' HOPE YOU HAD FUN!
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